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PSPB_Training 

General 

Workspace and PSPB Navigation 
EPM Workspace is the Web user interface that is used to access all Oracle Hyperion and non-
Oracle Hyperion content. Oracle Hyperion content includes Oracle's Hyperion financial 
applications and the Reporting and Analysis Framework. Workspace provides access to 
management reporting and query and analysis capabilities for a wide variety of data sources in a 
single coordinated environment.  
 
Workspace provides a centralized environment for users to access and interact with the following 
components: 

• Financial Management application tasks 
• Planning application tasks 
• High-performance, multidimensional modeling, analysis, and reporting with Web 

Analysis 
• Financial Reporting for scheduled or on-demand, highly formatted, financial and 

operational reporting from most data sources, including Financial Management and 
Planning 

• Access and interaction with other published content, such as Microsoft Word or Excel 
documents 

• Integration tasks to move data and metadata from Enterprise Resource Planning (ERP) 
source systems into Enterprise Performance Management (EPM) target applications 

Upon completion of this lesson, you should be able to:  

• Launch Workspace 
• Review the Workspace user interface 
• Set General and Explore preferences 
• Open Planning applications 
• Add favorites 

4.1 - Launching Workspace 
To start Planning, you log on to Workspace with your user name and password.  
  
Shared Services uses user names and passwords from the external authentication provider, such 
as Active Directory or Lightweight Directory Access Protocol (LDAP). On the Workspace logon 
page, you enter the user name and password that you use to access your network. When you 
select a Planning application, Planning verifies that your user name and password are valid for the 
application.  
  
In this topic, you log on to Workspace.  

Procedure 
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Step Action 
1. Begin by navigating to the Log On page. 

 
Double-click the Internet Explorer application. 

2. Enter the location and port of your Workspace server in the Address field, and press 
Enter. 
 
In this example, http://sok-hycdw01.sok.s365.us:19000/workspace/index.jsp was 
entered for you. 
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Step Action 
3. Click in the User Name field. 

 
4. The user name is not case-sensitive. 

 
Enter the desired information into the User Name field. Enter "<User Name>". 

5. Click in the Password field. 

 
6. The password is case-sensitive. 

 
Enter the desired information into the Password field. Enter "<Password>". 

7. Click the Log On button. 

 
8. You successfully logged on to Workspace. 

End of Procedure. 

4.2 - Changing Password 
In this topic you will change your password. 

Procedure 
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Step Action 
1. Click the Tools menu. 

 
2. Click the Change Password... menu. 

 
3. Enter the desired information into the Current Password: field. Enter "<Current 

Password>". 
4. Enter the desired information into the New Password: field. Enter "<New 

Password>". 
5. Enter the desired information into the Confirm Password: field. Enter "<Confirm 

Password>". 
6. Click the Save button. 

 
7.  

End of Procedure. 

4.3 - Setting General and Explore Preferences 
You can set preferences that change the general appearance of your Workspace user interface. 
For example, you can display the path for documents that you open in Workspace, and you can 
change the default start page. You can also set the preferences that define your default Explore 
folders. 
  
In this topic, you set General and Explore preferences. 

Procedure 



 

 Page 5 

 
 

 
 

Step Action 
1. When you log on to Workspace for the first time, a default Shared Workspace page 

is displayed. 
 
Begin by navigating to the Preferences dialog box. 
 
Click the File menu. 

 
2. Click the Preferences... list item. 

 
3. Use the General tab of the Preferences dialog box to define the general appearance 

of your Workspace user interface.  
4. Use the Content field to select the default startup option. 

 
Click the Content list. 

 
5. You can choose to open an application by default when you log on to Workspace. 

 
Click the Application list item. 
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Step Action 
6. Use the Application field to select the application that opens in Workspace by 

default. 
 
Click the Application list. 

 
7. Click the Planning list item. 
8. In this example, you select to open the SOKPLAN application after logging on to 

Workspace. 
 
Click the SOKPLAN list item. 

 
9. Use the Prompt to Save Unsaved Files field to set up prompts to save unsaved 

repository items. 
10. Use the Show Path For Documents field to display the full path for opened 

repository items. 
11. Navigate to the Explore preferences. 

 
Click the Explore button. 

12. Use the Default Folder field to select the folder that is displayed when you open 
Explore. 

13. Navigate to the default folder. 
 
Click the Select... button. 

 
14. Double-click the Root list item. 

 
15. In this example, select the Hyplan folder as the default Explore folder. 

 
Click the Hyplan list item. 

 
16. Click the OK button. 

 
17. Save the changes. 

 
Click the OK button. 

 
18. Preference changes become effective the next time that you log on. 

 
Click the File menu. 
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Step Action 
19. Log off Workspace. 

 
Click the Log Off list item. 

 
20. Click the Yes button. 

 
 

 
 

Step Action 
21. Click in the Password field. 

 
22. The password is case-sensitive. 

 
Enter the desired information into the Password field. Enter "<Password>". 

23. Click the Log On button. 

 
24. The SOKPLAN application is opened when you log on to Workspace. 
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Step Action 
25. Navigate to the Explore module. 

 
Click the Explore button. 

 
26. The SOKPLAN folder is displayed in the View Pane by default. 
27. You successfully set General and Explore preferences. 

End of Procedure. 

4.4 - Opening Planning Applications 
In Planning, all data is processed within applications. An application is a related set of 
dimensions and dimension members that meet analytical or reporting requirements; for example, 
an application named Testing for development and an application named Production for end 
users.  
  
In this topic, you open a Planning application.  

Procedure 
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Step Action 
1. Begin by navigating to the Hyplan application. 

 
Click the Navigate menu. 

 
2. Click the Applications menu. 

 
3. Click the Planning menu. 

 
4. Select an application. 

 
Click the SOKPLAN list item. 

 
5. The application is opened with the Form and Ad Hoc Grid Management page 

displayed. 
 
By default, Planning displays the data form or module that was opened in your 
previous session. 

6. You successfully opened a Planning application. 
End of Procedure. 

4.5 - Adding Favorites 
Favorites enable you to quickly access frequently used items and documents. With appropriate 
access permissions, you can add items to other users’ favorites.  
  
In this topic, you add documents to the Favorites folder.  
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Procedure 
 
 

 
 

Step Action 
1. Begin by navigating to the Human Capital Planning folder. 

 
Double-click the Human Capital Planning list item. 

 
2. Use the Human Capital Planning page to compare a full list of HCP reports. 
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Step Action 
3. Add the current page to the Favorites folder. 

 
Click the Favorites menu. 

 
4. Click the Add to Favorites list item. 

 
5. Close the Act-Bud Operating Margin report. 

 
Right-click the Act-Bud Operating Margin tab. 

 
6. Click the Close list item. 
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Step Action 
7. Click the Favorites menu. 

 
8. Notice that the folder is now listed as a favorite. 

 
Click the Human Capital Planning list item. 

 
9. The Human Capital Planning folder is displayed in the content area. 
10. You successfully added a folder to your favorites. 

End of Procedure. 

4.6 - Setup Misaligned Menus in Workspace 
Misaligned menus can negatively impact the ability to navigate through the menus and menu 
items in Hyperion. In this topic you will setup misaligned menus in Workspace through Internet 
Explorer. 

Procedure 
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Step Action 
1. Open up Internet Explorer.  Once open navigate to Internet Options by clicking the 

Tools menu. 
 
Click the Tools menu. 

 
2. Click the Internet options menu. 

 or Press [O]. 
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Step Action 
3. Click the Security tab. 

 
4. Click the Custom level... button. 
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Step Action 
5. Navigate to "Allow script initiated windows without size or position constraints" 

option 
 
Press the left mouse button over the scrollbar and drag the mouse to the desired 
location. 
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Step Action 
6. -Scroll down to the "Allow script initiated windows without size or position 

constraints" option 
 
Release the mouse button. 
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Step Action 

7. Click the Enable "Allow script initiated windows without size or position 
constraints" option 
 
Click the Enable option. 

 
 

 
 

Step Action 
8. Click the OK button. 

 
9. Warning box displays reading "Are you sure you want to change the settings for this 

zone?" 
 
Click the Yes button. 

 
10. Navigate to the OK button on the Internet Options page 

 
Click the OK button. 
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Step Action 
11. Launch Workspace 

 
Click the Launch Application... button. 
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Step Action 
12. Click the Maximize/Restore button. 

 
 

 
 

Step Action 
13. Enter the desired information into the Password: field. Enter "<Password>". 
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Step Action 
14. Click the Log On button. 

 
 

 
 



 

 Page 21 

Step Action 
15. Click the Navigate menu. 

 
16. Click the Applications menu. 

 
17. Click the Planning menu. 

 
 

 
 

Step Action 
18. All the misaligned menus are now properly aligned 

 
19.  

End of Procedure. 

4.7 - Reviewing the View Pane and Content Area 
After you open a Planning application, the View Pane and content area display your selections.  
 
For example, when you work with data form management, the View Pane lists form folders, data 
forms, and business rules. You can use the View Pane to navigate from one folder or data form to 
another. If you select a data form from the View Pane, its contents are displayed in the content 
area.  
  
In this topic, you review the View Pane and content area.  

Procedure 
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Step Action 
1. Begin by navigating to the SOKPLAN application. 

 
Click the Navigate menu. 

 
2. Click the Applications menu. 

 
3. Click the Planning menu. 

 
4. Click the SOKPLAN list item. 

 
5. By default, Planning displays the data form or module that was opened in your 

previous session. 
6. Use the View Pane to select items, documents, or data forms from a list. 
7. Use the content area to view a document or data form that you selected in the View 

Pane. 
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Step Action 
8. Hide the View Pane 

 
Click the Collapse Pane button. 

 
9. The View pane is hidden and the content area page is expanded. 
10. You successfully reviewed the View Pane and content area. 

End of Procedure. 

4.8 - Set User Preferences 
User preferences are settings that are specific to a User within Workspace.  In this topic you will 
set user preferences. 

Procedure 
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Step Action 
1. Click the Restore Pane button. 

 
2. Click the Preferences Expand button. 

 
3. Click the User Variable Options tab. 

 
4. Click the Scenario Member Selector button. 

 
5. Click the Budget list item. 

 
6. Click the Add button. 

 
7. Click the OK button. 

 
8. Click the Version Selected Member button. 

 
9. Click the Agency list item. 

 
10. Click the Add button. 
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Step Action 
11. Click the OK button. 

 
12. Click the Year Member Selector button. 

 
13. Click the All Years Expand button. 

 
14. Click the FY16 list item. 

 
15. Click the Add button. 

 
16. Click the OK button. 

 
17. Click the Request Member Selector button. 

 
18. Click the Total Request Expand button. 

 
19. Click the Current Service Level list item. 

 
20. Click the Add button. 

 
21. Click the OK button. 

 
22. Click the Save button. 

 
23. A message displays reading "User Preferences have been saved." 

 
Click the OK button. 

 
24. Click the Forms Expand button. 

 
25.  

End of Procedure. 

4.9 - Opening Data Forms 
Data forms are contained within folders. When you select a folder, a list of data forms is 
displayed in the View Pane and content area. The lists identify the data forms that are contained 
within the selected folder and that your assigned roles permit you to access.  
 
From the list of data forms, you can open a data form by selecting it either from the View Pane or 
from the content area.  
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In this topic, you open a data form.  

Procedure 
 
 

 
 

Step Action 
1. Begin by navigating to the SOKPLAN application. 

 
Click the Navigate menu. 

 
2. Click the Applications menu. 

 
3. Click the Planning menu. 

 
4. Click the SOKPLAN list item. 

 
5. By default, Planning displays the data form or module that was opened in your 

previous session. 
6. Use the View Pane to select items, documents, or data forms from a list. 
7. Use the content area to view a document or data form that you selected in the View 

Pane. 
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Step Action 
8. Drill down to under Forms. 

 
Click the Expand button. 

 
9. Open the Statistical Planning data form. 

 
Click the Statistical Planning list item. 

 
10. Open the Statistical Planning data form. 

 
Click the Healthcare list item. 

 
11. Use the Healthcare page to enter data. 
12. You successfully opened a data form. 

End of Procedure. 

4.10 - Add Comments 
Comments are a useful feature for identity data that is entered in fields. In this topic you will add 
comments. 

Procedure 
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Step Action 
1. Click the Navigate menu. 

 
2. Click the Applications menu. 

 
3. Click the Planning menu. 

 
4. Click the SOKPLAN menu. 

 
5. Click the Forms Expand button. 

 
6. Click the Operating Plan Expand button. 

 
7. Click in the Revenue Planning field. 

 
8. Double-click in the Revenue_01_Taxes field. 

 
9. Right-click the cell. 

 
10. Click in the Comments field. 
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Step Action 
11. Click the Actions menu. 

 
12. Click the Add list item. 

 
13. Enter the desired information into the Comment field. Enter "You can add a 

comment in any cell and an indicator will appear in the top right corner.". 
14. Click the Add button. 

 
 

 
 

Step Action 
15. The comment appears in the Comments window. 
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Step Action 
16. Click the Close button. 
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Step Action 
17. Indicator in top right corner lets user know there is a comment for that cell. 

 
18.  

End of Procedure. 

4.11 - Log Off Workspace 
In this topic you will log off Workspace. 

Procedure 
 
 

 
 

Step Action 
1. Enter the desired information into the User Name: field. Enter "<User Name:>". 
2. Enter the desired information into the Password: field. Enter "<Password>". 
3. Click the Log On button. 

 
4. Click the File menu. 

 
5. Click the Log Off menu. 
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Step Action 
6. A message displays reading "Are you sure you want to log off?" 

 
Click the Yes button. 

 
7.  

End of Procedure. 

Reporting 
Planning provides several tools for working with data forms and tasks:  

• Planning menus 
• Planning toolbar 
• View Pane 
• Content area 

Upon completion of this lesson, you should be able to:  

• Review menus 
• Select Advanced and Basic modes 
• Review the View Pane and content area 
• Open data forms 

4.12 - Setting Financial Reporting Preferences 
You can set Financial Reporting preferences for the Web client and for Reporting Studio. The 
General preferences define preferences for Financial Reporting in the Web client, such as the 
default preview mode of reports and the position of the POV. The Reporting Studio preferences 
define preferences for reports in Reporting Studio, such as the style and position of the guide 
lines.  
  
In this topic, you set Financial Reporting preferences.  

Procedure 
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Step Action 
1. Begin by navigating to the Preferences dialog box. 

 
Click the File menu. 

 
2. Click the Preferences... list item. 

 
3. Use the Preferences dialog box to set preferences for Financial Reporting, for the 

Workspace user interface, and for other installed products. 
4. Navigate to Financial Reporting preferences. 

 
Click the Financial Reporting tab. 

 
5. Use the General tab to define preferences when working with Financial Reporting 

in the Web client. 
6. Use the Default Preview Mode field to define the default mode for previewing 

reports and books in the Web client.   
 
For example, when you select HTML Preview as the default preview mode, and 
then double-click a report to open it, it opens in HTML Preview mode. 
 
Click the HTML Preview option. 

 
7. Use the Preview field to enable previewing the user POV before the report renders. 
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Step Action 
8. Use the Merge Equivalent Prompts option to respond only once to prompts that 

are repeated multiple times. 
 
Click the Merge Equivalent Prompts option. 

 
9. Use the Thousands Separator and Decimal Separator fields to specify the 

separators for formatting numbers in grids.  
 
The separators for formatting numbers in grids apply only if you select the Defined 
by Preferences option during report design. 

10. Use the Date Value Format field to specify the format of Essbase date values.   
11. Navigate to Reporting Studio preferences. 

 
Click the Reporting Studio tab. 

 
12. Use the Reporting Studio tab to define preferences when you are working with 

reports in Reporting Studio. 
13. Use the Guide Lines section to define the color, style, position, and snapping action 

of the guide lines. 
14. Select the Dot style for the guide lines. 

 
Click the Style: list. 

 
15. Click the Dot list item. 

 
16. Use the Guide Line Every field to specify the distance between the guide lines. 

 
Click in the Guide Line Every: field. 

 
17. Enter the desired information into the Guide Line Every: field. Enter "25". 
18. Use the Snap to Guide Line field to align objects along the guide lines of a report. 

 
Click the Snap to Guide Line option. 

 
19. Save your preferences. 

 
Click the OK button. 

 
20. You successfully set Financial Reporting preferences. 

End of Procedure. 
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4.13 - Browsing the Repository 
On the Explore page in Workspace, you can browse the repository to display Financial Reporting 
items, such as reports and books. In addition to Financial Reporting items, the Explore page can 
include items from other products, such as Interactive Reporting and Web Analysis, and third-
party documents, such as Microsoft Office documents.  
  
By default, the content area displays the name, type, date modified, and description of the items. 
You can display additional information, such as the owner and creation date, by adding columns 
to the content area. You can sort the columns to easily find specific items. For example, you can 
sort the items by the Type column to group all reports and books. You can also limit the content 
area to display specific types of items, such as books or reports.  
  
In this topic, you browse the repository.  
  

Procedure 
 
 

 
 

Step Action 
1. When you navigate to the Explore page in Workspace, the Root folder is selected 

by default. 
 
In this example, the Root folder contains folders, reports, and a row and column 
template. 
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Step Action 
2. Begin by navigating to the SOKPLAN folder. 

 
Click the SOKPLAN list item. 

 
3. Begin by navigating to the Human Capital Planning folder. 

 
Click the Human Capital Planning list item. 

 
4. When you select a folder in the View Pane, the folder items to which you have 

access are displayed in the content area.  
 
The items are sorted in ascending order by the Name column. 

5. When you select a folder in the View Pane, the folder items to which you have 
access are displayed in the content area.  
 
The items are sorted in ascending order by the Name column. 

6. Sort the item names in ascending order. 
 
Click the Name column header. 

 
7. The reports are sorted in ascending order by the name. 
8. Display the Owner column and remove the Description column. 

 
Click the View menu. 

 
9. Click the Show Columns... list item. 

 
10. Hide the Description column. 

 
Click the Description option. 

 
11. Display the Owner column. 

 
Click the Owner option. 

 
12. Save the changes. 

 
Click the Save button. 

 
13. The Owner column is displayed. The Description column is no longer displayed. 
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Step Action 
14. Display only reports and snapshot reports in the content area. 

 
Click the View menu. 

 
15. Click the Display Items Of Type menu. 

 
16. Click the All Reports list item. 

 
17. Reports and snapshot reports are displayed in the content area. 
18. You successfully browsed the repository. 

End of Procedure. 

4.14 - Changing the user POV 
Procedure 
 
 

 
 

Step Action 
1. Click the + button before the SOKPLAN tree item. 

 
2. Click the Line Item tree item. 
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Step Action 
3. Click the BRPSP tree item. 

 
4. Double-click the BRPSP tree item. 

 
5. Click the OK button. 

 
6. Click the ClassFund: ClassFund link. 

 
7. Click the Class Fund Expand Row button. 

 
8. Click the All_Class_Funds option. 

 
9. Click the OK button. 

 
 

 
 

Step Action 
10. Review the POV selection to "Class Funds" has been made 
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Step Action 
11. Click the BRPSP tab. 

 
12.  

End of Procedure. 

4.15 - Navigating a Report 
Procedure 
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Step Action 
1. Click the Human Capital Planning tree item. 

 
2. Right-click the Position Costing tree item. 

 
3. Click the Open In menu. 

 
4. Click the HTML Preview menu. 

 
5. Click the Go to Member Selection button. 

 
6. Click the Entity Expand Row button. 

 
7. Click the Total Entity Expand Row button. 

 
8. Click the All_Agencies Expand Row button. 

 
9. Click the 09000 Expand Row button. 

 
10. Click the 09000_10 Expand Row button. 
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Step Action 
11. Click the 09000_1000001 option. 

 
12. Click the Add to Selected button. 

 
13. Click the OK button. 

 
14. Click the OK button. 

 
 

 
 

Step Action 
15. Review the Report 
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Step Action 
16. Click the Log Off object. 

 
17. Click the Yes button. 

 
18.  

End of Procedure. 
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